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Aspen Graphics DDE Link คอือะไร 
 
Aspen Graphics DDE Link เป็นโปรแกรมเสรมิเพือ่ใชส้ ำหรบัดงึขอ้มูลจำก Aspen for Windows ไปยงั 
Microsoft Microsoft Excel และมกีำรอพัเดทขอ้มูลแบบไดนำมกิ โดยสำมำรถดงึขอ้มูลได ้3 รูปแบบ ดงันี ้

1. Quote ใชส้ ำหรบัดงึขอ้มูลของวนัปัจจบุนั 
2. History ใชส้ ำหรบัดงึขอ้มูลยอ้นหลงั 
3. Formula ใชส้ ำหรบัดงึขอ้มูลจำกสูตรทีส่รำ้งเอำไว ้

ซึง่กำรดงึขอ้มูลผ่ำน Aspen Graphics DDE Link จะตอ้งเปิดโปรแกรม Aspen for Windows กอ่นทุกคร ัง้  
 

ไฟลท์ีใ่ชส้ ำหรบัตดิต ัง้ Aspen Graphics DDE 

 

ไฟลต์ดิตัง้ Aspen Graphics DDE Link จะเก็บไวใ้น C:\Aspen\MSExlDDE ซึง่ประกอบไปดว้ยไฟลต่์ำงๆ ดงันี ้

1. โฟลเดอร ์IconDDE  
2. agdde32.dll (Date modified: 28 Aug 2014) 
3. ARG32.XLA (Date modified: 05 Nov 2014) เป็น Add-Ins ส ำหรบั Microsoft Excel 2003 
4. Arg32.xlam (Date modified: 18 Feb 2013) เป็น Add-Ins ส ำหรบั Microsoft Excel 2007 ขึน้ไป 
5. QMASTER.XLB (Date modified: 18 Feb 2013) ใชส้ ำหรบัเรยีกแถบเคร ือ่งมอื Aspen Graphics DDE บน 

Microsoft Excel 2003 
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วธิตีดิต ัง้ Aspen Graphics DDE บน Microsoft Excel 2003 

1. Copy ไฟล ์agdde32.dll ไวใ้น C:\Windows\System32 
2. เปิดโปรแกรม Microsoft Excel 
3. คลกิที ่Tools > Add-Ins 
4. จะปรำกฏหนำ้ต่ำง Add-Ins ขึน้มำ 

 

5. คลกิปุ่ม Browse แลว้เลอืกไดเรก็ทอรทีีต่ดิตัง้โปรแกรม Aspen Graphics โดยปกตจิะเป็น 
C:\Aspen\MSExlDDE 

 

6. ดบัเบิล้คลกิทีไ่ฟล ์ARG32 หรอื ARG32.XLA (File size: 137 KB | Date modified: 05 Nov 2014)  
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7. จะปรำกฎหนำ้ต่ำง Add-Ins และมเีคร ือ่งหมำย  หนำ้ค ำว่ำ “Aspen Graphics DDE Add-in”   

 

8. คลกิปุ่ม OK เพือ่ปิดหนำ้ต่ำง Add-Ins 
9. คลกิที ่File > Open แลว้เลอืกไฟล ์QMASTER.XLB จำกไดเรก็ทอร ีC:\Aspen\MsExlDDE  

 

10. จะมแีถบเคร ือ่งมอืของ Aspen Graphics DDE ขึน้มำ ดงัภำพ 

 

11. ปิดและเปิด Microsoft Excel ใหม่อกีคร ัง้ เพือ่ใหก้ำรตดิตัง้เสรจ็สมบูรณ ์
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วธิตีดิต ัง้ Aspen Graphics DDE บน Microsoft Excel 2007 ขึน้ไป 

1. Copy ไฟล ์agdde32.dll ไวใ้น C:\Windows\System32 

2. เปิดโปรแกรม Microsoft Excel 

3. คลกิที ่File > Options  

4. จะปรำกฏหนำ้ต่ำง Excel Options ขึน้มำ 

5. คลกิทีปุ่่ม Go ตรงดำ้นลำ่งของหนำ้ต่ำงนี ้จะปรำกฏหนำ้ตำ่ง Add-Ins ขึน้มำ 

6. คลกิปุ่ม Browse  

 

7. เลอืกไดเรก็ทอรทีีต่ดิตัง้โปรแกรม Aspen Graphics โดยปกตจิะเป็น C:\Aspen\MSExlDDE 

 

8. ดบัเบิล้คลกิทีไ่ฟล ์Arg32 หรอื Arg32.xlam (File size: 49 KB | Date Modified: 18 Feb 2013)  
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9. จะปรำกฎหนำ้ตำ่ง Add-Ins และมเีคร ือ่งหมำย หนำ้ค ำวำ่ “Arg32”   

 
10. คลกิปุ่ ม OK เพือ่ปิดหนำ้ตำ่ง Add-Ins 

11. ปิดและเปิด Microsoft Excel ใหม่อกีคร ัง้ เพือ่ใหก้ำรตดิตัง้เสรจ็สมบูรณ ์
 

แถบเคร ือ่งมอื Aspen Graphics DDE Link 
 
เมือ่ตดิตัง้ Aspen Graphics DDE เรยีบรอ้ยแลว้ จะมแีถบ Aspen Graphics และม ีAspen Graphics DDE 
Quick Link อยู่ในเมนู เมือ่คลกิปุ่มขวำของเมำ้ส ์ดงัภำพ 

» แถบเคร ือ่งมอื Aspen Graphics DDE Link บน Microsoft Excel 2007 ขึน้ไป 

 

» แถบเคร ือ่งมอื Aspen Graphics DDE Link บน Microsoft Excel 2003 
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กำรดงึขอ้มูลโควท (Quote) ออกไปยงั Microsoft Excel 
 
กำรดงึขอ้มูลโควท (Quote) ออกไปยงั Microsoft Excel สำมำรถท ำได ้2 วธิ ีคอื 

1. เมนู Create DDE Link  
2. เมนู Aspen Graphics DDE Quick Link 
 
โดยวธิกีำรใชง้ำนแต่ละวธิมีรีำยละเอยีด ดงันี ้

1. เมนู Create DDE Link  

ดงึขอ้มูล Quote ไดค้รำวละ 1 Symbol เท่ำน้ัน และหำกตอ้งกำรเปลีย่น Symbol หรอื Field จะตอ้งเขำ้ไปเปลีย่น
จำกแถบ Formula ใน Microsoft Excel แลว้กดปุ่ม Ctrl+Shift+Enter พรอ้มกนั หรอืเลอืก Create DDE Link 
ใหม่อกีคร ัง้ 

 

1. คลกิไอคอน Create DDE Link บนแถบเคร ือ่งมอื 
2. จะปรำกฎหนำ้ต่ำง DDE Link Generator Helper Dialog ขึน้มำบนหนำ้จอ 

 

เมนู รำยละเอยีด 

Symbol Symbol ของขอ้มูลทีต่อ้งกำรดงึขอ้มูล 

Short List  แสดง Field ขอ้มูลทีส่ ำคญั คลกิเพือ่เลอืกรูปแบบทีต่อ้งกำร 

Long List แสดง Field ขอ้มูลทัง้หมด คลกิเพือ่เลอืกรูปแบบทีต่อ้งกำร 

 

ปุ่ม รำยละเอยีด 

 ส่ง Field ทีเ่ลอืกไวไ้ปยงัชอ่ง Selected 

 ยำ้ย Field ทีเ่ลอืกไวอ้อกจำกชอ่ง Selected 
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ปุ่ม รำยละเอยีด 

 เลือ่นต ำแหน่งของ Field ทีเ่ลอืกไวใ้นชอ่ง Selected ขึน้ไปดำ้นบน 

 เลือ่นต ำแหน่งของ Field ทีเ่ลอืกไวใ้นชอ่ง Selected ลงมำดำ้นลำ่ง 

 ลบ Field ทีเ่ลอืกไวใ้นชอ่ง Selected ทัง้หมด 

 ดงึขอ้มูลทีเ่ลอืกไวไ้ปยงั Microsoft Excel 

 ไม่ตอ้งดงึขอ้มูลทีเ่ลอืกไว ้พรอ้มกบัปิดหนำ้ต่ำงนี ้

 
3. พมิพ ์Symbol ของขอ้มูลทีต่อ้งกำรดงึขอ้มูลในชอ่ง Symbol 
4. ดบัเบิล้คลกิยงั Field ทีต่อ้งกำรเลอืก โดย Field ทีเ่ลอืกแลว้ จะเขำ้ไปอยู่ในชอ่ง Selected  
5. คลกิปุ่ม Copy Link เพือ่ดงึขอ้มูลไปยงั Microsoft Excel 

 

6. ขอ้มูลทีเ่ลอืกไวจ้ะถูกส่งไปยงั Microsoft Excel และอพัเดทแบบไดนำมกิ 

 

 

 

 

 

 

 

รำยละเอยีด หรอื
ค ำอธบิำย Field ต่ำงๆ 
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2. เมนู Aspen Graphics DDE Quick Link 

ดงึขอ้มูล Quote และ Formula ไดค้รำวละหลำยๆ Symbol และกำรเปลีย่น Symbol หรอื Field สำมำรถท ำไดอ้ย่ำง
ง่ำยดำย เพยีงแค่พมิพ ์Symbol หรอื Field ใหม่ทีต่อ้งกำรไปแทนทีไ่ดเ้ลย 

 

โดยกำรดงึขอ้มูลผ่ำน Aspen Graphics DDE Quick Link สำมำรถท ำไดใ้น 2 รปูแบบ คอื 

1) Field as Column Header โดยให ้Field อยู่ในคอลมัน ์(Column) และ Symbol อยู่ในแถว (Row) 
2) Field as Row Header โดยให ้Field อยู่ในแถว (Row) และ Symbol อยู่ใน คอลมัน ์(Column) 
 
กำรดงึขอ้มูลแบบ Field as Column Header 

1. พมิพ ์Symbol ทีต่อ้งกำรดงึขอ้มูลไวใ้นแถวที ่2 (Row) เป็นตน้ไป 
2. พมิพช์ ือ่ Field หรอื Formula ทีต่อ้งกำรดงึขอ้มูลไวใ้นคอลมัน ์B (Column) เป็นตน้ไป 

 

3. น ำเคอรเ์ซอรเ์มำสม์ำวำงทีช่อ่ง A1 แลว้คลกิปุ่ม Field as Column Header บนแถบเคร ือ่งมอื หรอืคลกิปุ่มขวำ
ของเมำ้ส ์แลว้เลอืก Aspen Graphics DDE Quick Link > Field as Column Header 

  

 

พมิพ ์Symbol ที่

ตอ้งกำรเปลีย่นในเซลล ์
นี ้แลว้กดปุ่ม Enter 

วำงเคอรเ์ซอร ์
เมำสท์ีน่ี่ 
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4. หำกตอ้งกำรเปลีย่น Symbol หรอืเปลีย่นชือ่ Field หรอื Formula ใหพ้มิพ ์Symbol หรอืช ือ่ Field หรอืช ือ่ 
Formula ใหม่ทีต่อ้งกำรเปลีย่นไปแทนทีช่ ือ่เดมิไดเ้ลย แลว้กดปุ่ม Enter 

ตวัอย่ำงเชน่ ตอ้งกำรเปลีย่น Symbol จำก _USDX (US Dollar Index) เป็น SET (SET Index) พมิพ ์SET ในชอ่ง 
A5แลว้กดปุ่ม Enter (เดมิชอ่ง A5 เป็น Symbol: _USDX)  

 

กำรดงึขอ้มูลแบบ Field as Row Header 

1. พมิพ ์Field หรอืช ือ่ Formula ทีต่อ้งกำรดงึขอ้มูลไวใ้นแถวที ่2 (Row) เป็นตน้ไป  
2. พมิพ ์Symbol ทีต่อ้งกำรดงึขอ้มูลไวใ้นคอลมัน ์B (Column) เป็นตน้ไป 

 

3. น ำเคอรเ์ซอรเ์มำ้สม์ำวำงทีช่อ่ง A1 แลว้คลกิปุ่ม Field as Row Header บนแถบเคร ือ่งมอื หรอืคลกิปุ่มขวำของ
เมำ้ส ์แลว้เลอืก Aspen Graphics DDE Quick Link > Field as Row Header 

  

 

 

 

วำงเคอรเ์ซอร ์
เมำสท์ีน่ี่ 
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4. หำกตอ้งกำรเปลีย่น Symbol หรอืเปลีย่นชือ่ Field หรอื Formula ใหพ้มิพ ์Symbol หรอืช ือ่ Field หรอืช ือ่ 
Formula ใหม่ทีต่อ้งกำรเปลีย่นไปแทนทีช่ ือ่เดมิไดเ้ลย แลว้กดปุ่ม Enter 

ตวัอย่ำงเชน่ ตอ้งกำรเปลีย่น Formula จำก MACD_DAY และ SIGNAL_DAY เป็น PCHG1W และ PCHG1M 
ตำมล ำดบั  พมิพ ์PCHG1W ในชอ่ง A5 (เดมิชอ่ง A5 เป็น Formula ชือ่ MACD_DAY) และพมิพ ์PCHG1M ใน
ชอ่ง A6 (เดมิชอ่ง A6 เป็น Formula ชือ่ SIGNAL_DAY) 

 

กำรดงึขอ้มูลยอ้นหลงั (History) ออกไปยงั Microsoft Excel 
 
กำรดงึขอ้มูลยอ้นหลงัออกไปยงั Microsoft Excel ไดท้ัง้แบบขอ้มูลรำยนำทแีละขอ้มูลรำยวนั โดยมวีธิกีำร ดงันี ้
  
1. คลกิไอคอน Create DDE Link บนแถบเคร ือ่งมอื 
2. จะปรำกฎหนำ้ต่ำง DDE Link Generator Helper Dialog ขึน้มำบนหนำ้จอ 
3. คลกิทีแ่ถบ History 
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เมนู รำยละเอยีด 

Symbol Symbol ของขอ้มูลทีต่อ้งกำรดงึขอ้มูล 

Interval  ควำมกวำ้งของชว่งเวลำทีต่อ้งกำรว่ำตอ้งกำรขอ้มูลแบบรำยนำท ีรำยวนั หรอืรำยสปัดำห ์
เป็นตน้ 

ตวัเลอืก รำยละเอยีด 

Daily ขอ้มูลรำยวนั 

Intraday ขอ้มูลรำยนำท ีโดยระบุจ ำนวนนำททีีต่อ้งกำรในชอ่ง Span 

Tick ขอ้มูลรำย 0 นำท ีหรอืแสดงทุกรำยกำรทีเ่กดิขึน้ 

Weekly ขอ้มูลรำยสปัดำห ์

Monthly ขอ้มูลรำยเดอืน 

Quarterly ขอ้มูลรำยไตรมำส 

Skip gaps เปิด/ปิดชอ่งว่ำง (Gap) ในชว่งวนัหยุดนักขตัฤกษ ์ 
คลกิใหม้เีคร ือ่งหมำยหำกตอ้งกำรปิด Gap  

   
Time Series  ก ำหนดระยะเวลำทีต่อ้งกำรดงึขอ้มูล 

ตวัเลอืก รำยละเอยีด 

Start Date พมิพว์นัทีเ่ร ิม่ตน้ โดยพมิพใ์นรูปแบบ MM/DD/YY เชน่ 
6/15/13  

Start Time พมิพเ์วลำทีเ่ร ิม่ตน้ ใชส้ ำหรบักรณีเลอืก Interval เป็น Intraday 
หรอื Tick เท่ำน้ัน โดยพมิพเ์วลำในรูปแบบ 24 นำฬกิำ เชน่ 
14:00 

End Date พมิพว์นัทีส่ิน้สุด โดยพมิพใ์นรูปแบบ MM/DD/YY เชน่ 
6/15/13  

End Time พมิพเ์วลำทีส่ิน้สุด ใชส้ ำหรบักรณีเลอืก Interval เป็น Intraday 
หรอื Tick เท่ำน้ัน โดยพมิพเ์วลำในรูปแบบ 24 นำฬกิำ เชน่ 
14:00 

Max days จ ำนวนวนัทีต่อ้งกำรดงึขอ้มูล ใชส้ ำหรบั Interval แบบ Daily 
เท่ำน้ัน เชน่ 20 เพือ่ดงึขอ้มูลยอ้นหลงั 20 วนั 
ใชเ้มือ่ตอ้งกำรดงึขอ้มูลตำมจ ำนวนวนัทีร่ะบุเอำไว ้โดย Start 
Date และ End Date จะเปลีย่นไปเร ือ่ยๆ เมือ่ขึน้วนัใหม่ 
(Rollover) 

Periods จ ำนวนชว่งเวลำทีต่อ้งกำร ใชส้ ำหรบั Interval ทุกรูปแบบ 
ยกเวน้ Daily  
ใช ้เมือ่ตอ้งกำรดงึขอ้มูลตำมจ ำนวนวนัทีร่ะบุเอำไว ้โดย Start 
Date และ End Date จะเปลีย่นไปเร ือ่ยๆ เมือ่ขึน้วนัใหม่ 
(Rollover) 

Sort 
Descending 

เรยีงขอ้มูลตำมวนัทีใ่หม่ไปเกำ่ (Descending)  
หำกตอ้งกำรเปลีย่นวธิกีำรเรยีงเป็นจำกเกำ่ไปใหม่ (Ascending) 
ใหค้ลกิอกีคร ัง้หน่ึงเพือ่ใหเ้คร ือ่งหมำย  หำยไป 
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เมนู รำยละเอยีด 

Time Series ก ำหนดระยะเวลำทีต่อ้งกำรดงึขอ้มูล 

ตวัเลอืก รำยละเอยีด 

Display N/A as 
Blank 

ตอ้งกำรเปลีย่นจำก N/A เป็นชอ่งว่ำงหรอืไม่  
คลกิใหม้เีคร ือ่งหมำย เพือ่เปลีย่นจำก N/A เป็น
ชอ่งว่ำง 

   
Quote Elements 
 

เลอืก Field ทีต่อ้งกำรดงึขอ้มูลยอ้นหลงัโดยคลกิใหม้แีถบสฟ้ีำที ่Field น้ันๆ  

Field รำยละเอยีด 

SYMBOL แสดง Symbol ของขอ้มูล 

DATE วนัที ่

TIME เวลำ 

HIGH รำคำสูงสุด 

LOW รำคำต ่ำสุด 

OPEN รำคำเปิด 

CLOSE รำคำปิด 

VOLUME ปรมิำณกำรซือ้ขำย 

OPEN INTEREST มูลค่ำกำรซ ือ้ขำย (ส ำหรบัหุน้) หรอื  
Open Interest (ส ำหรบัฟิวเจอรส์) 

   
 

ปุ่ม รำยละเอยีด 

 ลบ Field ทีเ่ลอืกไวใ้นชอ่ง Quote Elements ทัง้หมด แถบสฟ้ีำจะหำยไป 

 ดงึขอ้มูลทีเ่ลอืกไวไ้ปยงั Microsoft Excel 

 ไม่ตอ้งดงึขอ้มูลทีเ่ลอืกไว ้พรอ้มกบัปิดหนำ้ต่ำงนี ้

 
4. พมิพ ์Symbol ของขอ้มูลทีต่อ้งกำรดงึขอ้มูลในชอ่ง Symbol 

5. คลกิเลอืกชว่งเวลำของขอ้มูลกรำฟทีต่อ้งกำรในชอ่ง Interval เชน่ Daily 

6. คลกิใหม้เีคร ือ่งหมำยที ่Skip gaps เพือ่ปิดชอ่งว่ำงในชว่งวนัหยุดนักขตัฤกษ ์

7. ก ำหนดระยะเวลำทีต่อ้งกำรในชอ่ง Time Series เชน่ Start Date 6/1/12 และ End Date 6/30/13  

8. หำกตอ้งกำรเรยีงขอ้มูลตำมวนัทีจ่ำกเกำ่ไปใหม่ ใหค้ลกิทีช่อ่งหนำ้ Sort Descending เพือ่เอำเคร ือ่งหมำย  
ออกไป 

9. เลอืก Field ทีต่อ้งกำรดงึขอ้มูลในชอ่ง Quote Elements ส ำหรบั Field ทีไ่ม่ตอ้งกำรใหค้ลกิเมำ้สท์ี ่Field น้ันๆ 
เพือ่ใหแ้ถบสฟ้ีำหำยไป 
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10. คลกิปุ่ม Copy Link เพือ่ดงึขอ้มูลไปยงั Microsoft Excel 

 

11. ขอ้มูลทีเ่ลอืกไวจ้ะถูกส่งไปยงั Microsoft Excel และอพัเดทแบบไดนำมกิ 
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กำรดงึขอ้มูลจำกสูตรค ำนวณ (Formula) ออกไปยงั Microsoft Excel 
 
ดงึขอ้มูลจำกสูตรค ำนวณ (Formula) ทีเ่ขยีนโดยใชฟั้งกช์นั CHART() ออกไปยงั Microsoft Excel ได ้โดยมวีธิกีำร 
ดงันี ้
  
1. คลกิไอคอน Create DDE Link บนแถบเคร ือ่งมอื 
2. จะปรำกฎหนำ้ต่ำง DDE Link Generator Helper Dialog ขึน้มำบนหนำ้จอ 
3. คลกิทีแ่ถบ Formula 
4. พมิพช์ ือ่ Formula แลว้ตำมดว้ย Symbol ในรูปแบบนี ้

Formula_Name(Symbol) 
5. คลกิปุ่ม Copy Link เพือ่ดงึขอ้มูลไปยงั Microsoft Excel 

 

6. ขอ้มูลทีต่อ้งกำรจะถูกส่งไปยงั Microsoft Excel และอพัเดทแบบไดนำมกิ 
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กำรอพัเดทขอ้มูลใน Microsoft Excel 
 
ขอ้มูลใน Microsoft Excel จะอพัเดทแบบไดนำมกิ ก็ต่อเมือ่โปรแกรม Aspen for Windows ไดถู้กเปิดไวเ้ท่ำน้ัน  
 
เมือ่สรำ้งไฟลท์ีด่งึขอ้มูลแบบ DDE จำก Aspen for Windows ออกมำ แลว้ท ำกำร Save เก็บไวใ้ชค้รำวต่อไป เมือ่
เปิดไฟลข์ึน้มำใหม่ทุกคร ัง้ จะปรำกฎหนำ้ต่ำงขอ้ควำมถำมว่ำ ตอ้งกำรจะอพัเดทขอ้มูลหรอืไม่ ใหค้ลกิปุ่ม Update 
เพือ่อพัเดทขอ้มูล  

 

ตำรำงแสดงชือ่ Field ทีด่งึขอ้มูลไปยงั Microsoft Excel ได ้
 

ชือ่ Field รำยละเอยีด ประเภทขอ้มูล 

DESC ชือ่เต็มของ Symbol ขอ้มูลเกีย่วกบั Symbol 

EXPDATE วนัหมดอำยุของ Warrant/DW ขอ้มูลเกีย่วกบั Symbol 

EXPIRE วนัหมดอำยุของ Futures & Options (MM/DD/YY) ขอ้มูลเกีย่วกบั Symbol 

INDUSTRY กลุ่มอุตสำหกรรม ขอ้มูลเกีย่วกบั Symbol 

LISTDATE วนัทีเ่ร ิม่ท ำกำรซ ือ้ขำย ขอ้มูลเกีย่วกบั Symbol 

SECTOR หมวดธรุกจิ ขอ้มูลเกีย่วกบั Symbol 

SYMB Symbol  ขอ้มูลเกีย่วกบั Symbol 

UNDERLYING หลกัทรพัย/์สนิทรพัยอ์ำ้งองิ ขอ้มูลเกีย่วกบั Symbol 

XMONTH เดอืนทีห่มดอำยุของ Futures & Options ขอ้มูลเกีย่วกบั Symbol 

BV มูลค่ำทำงบญัชตีอ่หุน้ (Book value per share) ขอ้มูลพืน้ฐำน 

DPS เงนิปันผลต่อหุน้ (Dividend per share) ขอ้มูลพืน้ฐำน 

EPS ก ำไรต่อหุน้ (Earning per share) ขอ้มูลพืน้ฐำน 

LSHARE จ ำนวนหุน้จดทะเบยีน (Listed shares) หน่วย: 100 หุน้ ขอ้มูลพืน้ฐำน 

MCAP มำรเ์ก็ตแคป (Market capitalization) หน่วย: ลำ้นบำท ขอ้มูลพืน้ฐำน 

MCAPR สดัส่วนมำรเ์ก็ตแคปเทยีบกบัมำรเ์ก็ตแคปของดชันี (%MCAP) ขอ้มูลพืน้ฐำน 

MIMPACT Market impact ขอ้มูลพืน้ฐำน 

PBV รำคำต่อมูลคำ่ทำงบญัชตี่อหุน้ (Price per book value) ขอ้มูลพืน้ฐำน 

PERATIO อตัรำส่วนรำคำต่อก ำไรต่อหุน้ (Price earnings ratio) ขอ้มูลพืน้ฐำน 

YLD อตัรำส่วนเงนิปันผลตอบแทน (Dividend Yield) หน่วย: % ขอ้มูลพืน้ฐำน 
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ชือ่ Field รำยละเอยีด ประเภทขอ้มูล 

ASK รำคำเสนอขำยล ำดบัที ่1 (Offer 1) ขอ้มูลรำคำ 

ASK2 รำคำเสนอขำยล ำดบัที ่2 (Offer 2) ขอ้มูลรำคำ 

ASK3 รำคำเสนอขำยล ำดบัที ่3 (Offer 3) ขอ้มูลรำคำ 

ASK4 รำคำเสนอขำยล ำดบัที ่4 (Offer 4) ขอ้มูลรำคำ 

ASK5 รำคำเสนอขำยล ำดบัที ่5 (Offer 5) ขอ้มูลรำคำ 

ASKSIZE ปรมิำณเสนอขำยล ำดบัที ่1 (Offer Vol. 1) ขอ้มูลรำคำ 

ASKSIZE2 ปรมิำณเสนอขำยล ำดบัที ่2 (Offer Vol. 2) ขอ้มูลรำคำ 

ASKSIZE2 ปรมิำณเสนอขำยล ำดบัที ่2 (Offer Vol. 2) ขอ้มูลรำคำ 

ASKSIZE3 ปรมิำณเสนอขำยล ำดบัที ่3 (Offer Vol. 3) ขอ้มูลรำคำ 

ASKSIZE4 ปรมิำณเสนอขำยล ำดบัที ่4 (Offer Vol. 4) ขอ้มูลรำคำ 

ASKSIZE5 ปรมิำณเสนอขำยล ำดบัที ่5 (Offer Vol. 5) ขอ้มูลรำคำ 

BETA ค่ำเบตำ้ของหุน้รำยตวั (ขอ้มูลจำก ตลท.) ขอ้มูลรำคำ 

BID รำคำเสนอซือ้ล ำดบัที ่1 (Bid 1) ขอ้มูลรำคำ 

BID2 รำคำเสนอซือ้ล ำดบัที ่2 (Bid 2) ขอ้มูลรำคำ 

BID3 รำคำเสนอซือ้ล ำดบัที ่3 (Bid 3) ขอ้มูลรำคำ 

BID4 รำคำเสนอซือ้ล ำดบัที ่4 (Bid 4) ขอ้มูลรำคำ 

BID5 รำคำเสนอซือ้ล ำดบัที ่5 (Bid 5) ขอ้มูลรำคำ 

BIDSIZE ปรมิำณเสนอซือ้ล ำดบัที ่1 (Bid Vol. 1) ขอ้มูลรำคำ 

BIDSIZE2 ปรมิำณเสนอซือ้ล ำดบัที ่2 (Bid Vol. 2) ขอ้มูลรำคำ 

BIDSIZE3 ปรมิำณเสนอซือ้ล ำดบัที ่3 (Bid Vol. 3) ขอ้มูลรำคำ 

BIDSIZE4 ปรมิำณเสนอซือ้ล ำดบัที ่4 (Bid Vol. 4) ขอ้มูลรำคำ 

BIDSIZE5 ปรมิำณเสนอซือ้ล ำดบัที ่5 (Bid Vol. 5) ขอ้มูลรำคำ 

BUYVOLUME ปรมิำณจำกฝ่ังซ ือ้ (Buy Volume) ขอ้มูลรำคำ 

CEIL รำคำ Ceiling ขอ้มูลรำคำ 

CHANGE ค่ำ Change เมือ่เทยีบกบัรำคำปิดวนักอ่นหนำ้ ขอ้มูลรำคำ 

CLOSE1M รำคำปิดในรอบ 1 เดอืนทีแ่ลว้ (ค่ำของวนักอ่น) ขอ้มูลรำคำ 

CLOSE1W รำคำปิดในรอบ 1 สปัดำหท์ีแ่ลว้ (ค่ำของวนักอ่น) ขอ้มูลรำคำ 

CLOSE1Y รำคำปิดในรอบ 1 ปีทีแ่ลว้ (ค่ำของวนักอ่น) ขอ้มูลรำคำ 

CLOSE3M รำคำปิดในรอบ 3 เดอืนทีแ่ลว้ (ค่ำของวนักอ่น) ขอ้มูลรำคำ 

CLOSE6M รำคำปิดในรอบ 6 เดอืนทีแ่ลว้ (ค่ำของวนักอ่น) ขอ้มูลรำคำ 

EXPRICE รำคำใชส้ทิธิ ์ ขอ้มูลรำคำ 

EXRATIO อตัรำกำรใชส้ทิธิ ์ ขอ้มูลรำคำ 

FFLOAT ค่ำฟรโีฟลท (Free Float) ขอ้มูลรำคำ 
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ชือ่ Field รำยละเอยีด ประเภทขอ้มูล 

FLOR รำคำ Floor ขอ้มูลรำคำ 

HI52W รำคำสูงสุดในรอบ 52 สปัดำห ์(ค่ำของวนักอ่น) ขอ้มูลรำคำ 

HIGH รำคำสูงสุดของวนั ขอ้มูลรำคำ 

LAST รำคำล่ำสุด (รวมรำคำ Bid และ Offer ดว้ย) ขอ้มูลรำคำ 

LO52W รำคำต ่ำสุดในรอบ 52 สปัดำห ์(ค่ำของวนักอ่น) ขอ้มูลรำคำ 

LOW รำคำต ่ำสุดของวนั ขอ้มูลรำคำ 

LTDATE วนัท ำกำรซ ือ้ขำยสุดทำ้ยของ DW ขอ้มูลรำคำ 

NET ค่ำ Change เมือ่เทยีบกบัรำคำปิดวนักอ่นหนำ้ ขอ้มูลรำคำ 

OPEN รำคำเปิดของวนั ขอ้มูลรำคำ 

PCTCHG % กำรเปลีย่นแปลงวนันี ้(ค่ำของวนันี)้  ขอ้มูลรำคำ 

PCTCHG1M % กำรเปลีย่นแปลงในรอบ 1 เดอืน (ค่ำของวนักอ่น) ขอ้มูลรำคำ 

PCTCHG1W % กำรเปลีย่นแปลงในรอบ 1 สปัดำห ์(ค่ำของวนักอ่น)  ขอ้มูลรำคำ 

PCTCHG1Y % กำรเปลีย่นแปลงในรอบ 1 ปี (ค่ำของวนักอ่น) ขอ้มูลรำคำ 

PCTCHG3M % กำรเปลีย่นแปลงในรอบ 3 เดอืน (ค่ำของวนักอ่น) ขอ้มูลรำคำ 

PCTCHG6M % กำรเปลีย่นแปลงในรอบ 6 เดอืน (ค่ำของวนักอ่น) ขอ้มูลรำคำ 

PREV รำคำปิดวนักอ่น ขอ้มูลรำคำ 

PREVAVGVOL5D ค่ำเฉลีย่ 5 วนัของ Volume (ค่ำของวนักอ่น) ขอ้มูลรำคำ 

PREVOI Open Interest ของวนักอ่น ขอ้มูลรำคำ 

PROJECTED รำคำ Projected  ขอ้มูลรำคำ 

PROJVOL ปรมิำณซือ้ขำยในชว่ง Projected ขอ้มูลรำคำ 

RECENT รำคำเทรดล่ำสุด ขอ้มูลรำคำ 

SELLVOLUME ปรมิำณจำกฝ่ังขำย (Sell Volume) ขอ้มูลรำคำ 

TIME เวลำเทรดล่ำสุด ขอ้มูลรำคำ 

TRADE รำคำเทรดล่ำสุด ขอ้มูลรำคำ 

TRADESIDE ฝ่ังของรำคำเทรดว่ำมำจำกฝ่ังซ ือ้ (B) หรอืฝ่ังขำย(S)  ขอ้มูลรำคำ 

TRADESIZE ปรมิำณของรำยกำรเทรดลำ่สุด  ขอ้มูลรำคำ 

VALUE มูลค่ำกำรซ ือ้ขำยสะสม  ขอ้มูลรำคำ 

VOLUME ปรมิำณกำรซือ้ขำยสะสม  ขอ้มูลรำคำ 

VWAP รำคำเฉลีย่แบบ Volume Weighted Average ขอ้มูลรำคำ 
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